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How to Play

This section contains information about how to play Maze Master.

Overview 
Playing the Game 
Game Window 
Scoring 
Strategy and Hints 

Copyright © 1992 by The Flatirons Group.    All rights reserved.



Overview

Maze Master is a classic maze solving game, with a computer twist.    The computer can solve the 
tough mazes, too!

You are the mouse, peeking over the maze to study it, getting down on all four legs to run through it 
some, then peeking again! 

Start with the easy mazes, then move all the way to the very tough Monster mazes!    Then raise the 
walls so you can't peek!

You get points for solving the maze, and bonus points if you solve it quickly.    Score enough and you 
can make the list of the top 5 all-time players!

Traveling and not near your computer?    Print out a book of mazes to entertain the kids (and 
yourself)!

Bonus for Registered Users:

Plus, there are great sound effects for registered users running Windows 3.1!

Related Topics

Playing the Game 
Game Window 
Scoring
Strategy and Hints 

Commands 



Playing the Game

In Maze Master, you are the mouse!    You must trace your way from through the maze, starting at the 
left and leaving the maze on the right.

The mouse shape helps you.    Normally, the mouse is standing to scan the maze.    But when you 
press the left mouse button, your mouse gets down on all fours at the beginning of the maze.

You can rest at any time by releasing the mouse button.    Your mouse peeks up to study the maze.    
Pressing down on the left mouse button again moves you back to all fours at the point you left off.

The amount of the maze you can see varies with the size of the walls of the maze.    With low walls, 
you can see the whole maze before you start (but the walls are still too high to climb).    With high 
walls, you can only see the walls in front, to the sides, and in back of you.    If you declare yourself a 
blind mouse, you can only feel the walls around you.    And if you dare, make the walls glass!    With 
glass walls, you can't see them, only bump your nose into them!

If you get frustrated, let the computer solve the maze by selecting the Solve option under the Maze 
menu.

To Start Solving a Maze:

Press the left mouse button (to get down on all fours) and start moving through the maze.    Your 
mouse automatically moves to the beginning of the maze.

To Pause While Solving a Maze:

Release the left mouse button (to stand up and peek).

To Continue Solving a Maze:

Press the left mouse button again (to get down on all fours) and start moving through the maze.    
Your mouse automatically moves to the spot where you stopped.

To Back Up While Solving a Maze:

Press the left mouse button (to get down on all fours) and move backwards.    Your mouse 
automatically moves to the spot where you stopped.

Or, if you want to back up a lot, move to the spot on the path you wish to back up to, and press the 
right mouse button.    Then press the left mouse button to continue solving.

To Draw a New Maze:

From the Maze menu, choose New.    Or press F2.    Or press the New button (if visible).    Or from the 
Size menu, pick a new maze size.

To Change the Maze Size:

From the Size menu, select one of the standard sizes (Beginner, Intermediate, Expert, or Monster).    
Or select Custom and set your own size.

To Replay the Same Maze:

From the Maze menu, choose Draw Maze Again.    Or press F3.    Or press the Again button (if 
visible).

To Change the Type of Maze Walls:

From the Walls menu, choose a new wall style.    With low walls, you can see the whole maze at the 
start; with high walls, you only see walls when you enter the maze; with the blind mouse option, you 
can only feel the walls around you; and with the glass walls option, you never see walls (good luck 
with this option).

To Let the Computer Solve the Maze:

From the Maze menu, choose Solve.    You can see the computer checking the various paths through 



the maze if the Show Computer Solving item is checked in the Options Menu.

To Play a Particular Maze:

From the Size menu, choose Custom.    Enter the particular maze number you wish to play.    Maze 
numbers are in the title bar of the window, and noted in the records.

To See the Record Scores:

From the Size menu, select one of the standard sizes (not Custom).    Then from the Maze menu, 
select High Scores.    Or press the Best button (if visible).    Or, from a score dialog, press the Best 
button.    In any case, the top 5 all-time scores for each maze size are displayed, and the top 5 scores 
for the day are displayed.

Related Topics

Game Window 
Scoring
Strategy and Hints 

Commands 



The Game Window

The game window consists of one or two areas:

* the maze area (required)

* the score display (optional)

The maze area is where the maze is drawn.    The mouse must start on the left edge, and exit on the 
right edge.

Score Display

The score display is enabled by selecting the Score Display at Left item of the Options menu.    The 
score display is disabled by selecting the Hide Score Display item of the Options menu.    When 
displayed, the following is shown:

Base Score (see Scoring ),

Time Bonus (see Scoring ),

 to start a new maze of the same size,

 to restart the same maze (active only if you have started solving the maze, or the computer 
has solved the maze),

 to change to the next larger size maze (Custom mazes are considered to be the largest 
mazes regardless of their true size),

 to change to the next smaller size maze (Custom mazes are considered to be the largest 
mazes regardless of their true size),

 to show the high scores for this size of maze, and

 to invoke Maze Help.

If the screen is too small, some of the score display may be clipped.

Mouse Cursors

The mouse cursor changes shape when moved into the maze area according to the table below:

Small 
Mazes

Large 
Mazes

Left Button Up

Left Button Pressed

Related Topics

Playing the Game 
Scoring
Strategy and Hints 



Commands 



Scoring

Your Base Score is the points you earn for solving the maze.    You get 100 points for each step in the 
solution, but you lose those 100 points if you back up, plus an extra penalty of 25 points (for a total 
penalty of 125 points).    You get more points for solving a complicated maze with a long solution than 
points for solving a simple maze with an easy solution.    So look forward to hard mazes!

In addition, you get a    Time Bonus for solving the maze quickly.    The size of the bonus varies with 
the size of the maze, but it is set so that on a good run, you can increase your points by about 50%.    
The bonus is initially set high, and is reduced by 250 points each second.    The bonus is never less 
than zero. 

Your Total Score is the sum of the Base Score and the Time Bonus.

Your Total Score can also be doubled, tripled, or even quadrupled!    This is based on the type of walls 
you are using.    Low walls have no effect on your score.    High walls will double your base score and 
double your initial time bonus.    Blind Mouse triples these values, and Glass    walls quadruple these 
values.

Also for all wall levels other than Low walls, the time bonus does not start decreasing until you start 
solving the maze (there is nothing to peek at to cheat anyway!). 

In summary (including sample intermediate bonus starting value):

Wall Type Step Value Dead End Penalty Intermediate   Bonus  
Low 100 125 4,500
High 200 250 9,000

Blind Mouse 300 375 14,000
Glass 400 500 18,500

Records are kept on the 5 best all-time scores and for the 5 best daily scores for each of the major 
maze sizes.    Sorry, but no records allowed if the computer solved it first!

Related Topics

Playing the Game 
Game Window 
Strategy and Hints 

Commands 
Score Dialog 
Top Scores Dialog 



Strategy and Hints

This section contains helpful hints for playing Maze Master successfully.

* Spend time studying the maze (if you are using low walls) before getting down on all fours to 
solve.

* Look at the maze from both ends (if you are using low walls).    Tracing backward by eye can 
eliminate large sections of the maze you would spend valuable time exploring from the forward 
direction.

* Be sloppy with your mouse moving.    The mouse is pretty smart about tracing diagonals in a 
logical way.

* Don't worry about accidentally tracing into a dead end for a few spaces; in the large point totals, 
the 25 point penalty is small.

* Set records by having the same maze drawn again and solving it several times.

* Set records by using advanced wall levels, especially high walls and blind mouse.

* Beat an old record by selecting the specific maze on which the record was set, and then solving it 
yourself.    You can select the record maze by displaying the High Scores, noting the winning 
maze number, then using the Custom item of the Size menu to select that particular maze.

* Once you get used to the mouse movements, play with the walls options.    High walls are the 
most fun (I think), but you can also try the even harder levels of blind mouse and glass walls.

Related Topics

Playing the Game 
Game Window 
Scoring

Commands 



Commands

This section contains information about commands in Maze Master.

Maze Menu Commands 
Size Menu Commands 
Walls Menu Commands 
Options Menu Commands 
Registration Menu Commands
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Maze Menu Commands

This section contains information about Maze menu commands in Maze Master.

New

Creates a new maze of the same size to be solved.

Draw Maze Again

Draws the current maze again without a computer solution or your solution -- a fresh start!    Useful for 
setting records.

High Scores

Shows the records for the current maze size.    Records are only kept for the standard maze sizes 
(see Size menu).

Solve

Solves the maze.    If the Show Computer Solving item on the Options menu is checked, the dead 
ends the computer tries are shown (recommended!).

Print

Prints the currently displayed maze.    (Sorry, it doesn't print a solution!)

Batch Print

Prints up to one hundred (100) mazes of the current size (again, without solutions).

Printer Setup

Invokes your default printer's setup.    Maze Master will print either in landscape or portrait if your 
printer supports it.    If you wish to change to a different printer, it is necessary to change your default 
printer temporarily.

About Maze Master

Information about Maze Master.

Exit

Exits Maze Master.    You can exit anytime, even in the middle of solving a maze.    Any new records 
are saved.



Size Menu Commands

This section contains information about Size menu commands in Maze Master.

Beginner

Sets the maze size to 8 by 8, and draws a new maze that size.

Intermediate

Sets the maze size to 14 by 14, and draws a new maze that size.

Expert

Sets the maze size to 20 by 20, and draws a new maze that size.

Monster

Sets the maze size to 40 by 40, and draws a new maze that size.

Custom

Allows you to set the maze size to any values you want (within reason!). 

Also allows you to pick a particular maze to play.    This is useful for loading a previous maze on which 
a record was set, and then beating that record.



Walls Menu Commands

This section contains information about Size menu commands in Maze Master.

Low

This is the easiest setting!    The walls are low enough that the mouse can peek over the top when he 
is standing.    Thus, all the walls are shown when the maze is drawn.

High

This is a more realistic setting.    The walls are too tall to see over.    But once you enter the maze, the 
mouse can see the walls in each direction.    If a wall in one direction is far away, the mouse can see 
that far, plus see all the side walls and side passageways. 

Blind Mouse

This is a tough setting.    Basically, the mouse is blind ("3 Blind Mice").    The mouse only knows the 
walls immediately around it which can be felt.    You explore a lot of dead ends this way, but this is the 
way the computer solves the maze!

Glass

This is the hardest setting.    All the walls are transparent.    The mouse only knows one is there when 
it cannot go any further in that direction.    Plus, even after running into a wall, that wall is not marked! 
The mouse has to remember the blind passageways or stay forever lost.    This is a nearly impossible 
task on Monster mazes or larger.



Options Menu Commands

This section contains information about Options menu commands in Maze Master.

Score Display at Left

Displays both the base score and the time bonus in the margin left of the maze.    This lets you know 
how you are doing, but can be distracting.    If you need room for a bigger maze, select Hide Score 
Display.

Hide Score Display

Removes both the base score and the time bonus from the display.    This gives you    room for a 
bigger maze, and removes the distraction of the bonus countdown.

Show Computer Solving

Displays all the dead ends the computer takes when you request the maze be solved (by selecting 
Solve in the Maze menu.

Time Computer

Displays the time it took the computer to solve the maze and draw the solution.    The computer uses 
the blind mouse wall level to solve the maze.    Leave this off -- it's too embarrassing.

Color / Black & White

Displays your path and the computers path in color (or black & white).    Select black & white on 
monochrome and most non-color LCD screens.

Turn Sound Off / On

Turns the sound effects on or off.    Under Windows 3.0, the sound effects are just speaker beeps.    
Under Windows 3.1, two types of sound effects can be heard:    The standard Windows sound events 
for dialogs (per your Control Panel settings), and for registered users, an extended set of sound 
effects for the various events like running the maze, finishing first, etc.



Registration Menu Commands

This section contains information about Registration menu commands in Maze Master.

Enter Password

Allows you to register your copy of Maze Master.    Enter your name as shown on your registration 
form, and the password.    You should receive a "thank-you" for registering.

If you were using a friend's registered copy, use Enter Password to enter your own registration name 
and password.

Registration Form

Displays the help screen with the registration form.    Use the Print Topic item under the File menu of 
this help manager to print the registration form.    Then simply fill it out and mail it in.    By return mail, 
you will receive your registration password, and the support and update benefits registration brings.

Registration Information

Displays the help screen describing how to registering your copy of Maze Master.    In addition, this 
topic has information on the Maze Master warranty and support.

Shareware Information

Displays the help screen describing shareware -- what it is, what it is not, and why it is a great deal for 
you.    Maze Master is not free; you should register it after trying it, or remove it from your computer(s). 
Shareware is the ultimate money-back guarantee of your satisfaction since you pay nothing to try it.

Related Topics

Shareware -- Explanation and Benefits
Registration Instructions and Warranty
Registration Form



Shareware --    Explanation and Benefits

Shareware is a good deal for you!

Shareware distribution gives users a chance to try software before buying it.    If you try a Shareware 
program and continue using it, you are expected to register.    Individual programs differ on details -- 
some request registration while others require it, some specify a maximum trial period.    With 
registration, you get anything from the simple right to continue using the software to an updated 
program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder retains all 
rights, with a few specific exceptions as stated below.    Shareware authors are accomplished 
programmers, just like commercial authors, and the programs are of comparable quality.    (In both 
cases, there are good programs and bad ones!)    The main difference is in the method of distribution. 
The author specifically grants the right to copy and distribute the software, either to all and sundry or 
to a specific group.    For example, some authors require written permission before a commercial disk 
vendor may copy their Shareware.

Shareware is a distribution method, not a type of software.    You should find software that suits your 
needs and pocketbook, whether it's commercial or Shareware.    The Shareware system makes fitting 
your needs easier, because you can try before you buy.    And because the overhead is low, prices are 
low also.    Shareware has the ultimate money-back guarantee -- if you don't use the product, you 
don't pay for it.

Disclaimer - Agreement

Users of Maze Master must accept this disclaimer of warranty:    "Maze Master is supplied as is.    The 
author disclaims all warranties, expressed or implied, including, without limitation, the warranties of 
merchantability and of fitness for any purpose.    The author assumes no liability for damages, direct 
or consequential, which may result from the use of Maze Master."

Maze Master is a "shareware program" and is provided at no charge to the user for evaluation.    Feel 
free to share it with your friends, but please do not give it away altered or as part of another system.    
The essence of "user-supported" software is to provide personal computer users with quality software 
without high prices, and yet to provide incentive for programmers to continue to develop new 
products.    If you find this program useful and find that you are using Maze Master and continue to 
use Maze Master after a reasonable trial period, you must make a registration payment of $15 ($20 
for foreign users) to The Flatirons Group.    The $15 (or $20) registration fee will license one copy for 
use on any one computer at any one time.    You must treat this software just like a book.    An 
example is that this software may be used by any number of people and may be freely moved from 
one computer location to another, so long as there is no possibility of it being used at one location 
while it's being used at another.    Just as a book cannot be read by two different persons at the same 
time.

Commercial users of Maze Master must register and pay for their copies of Maze Master within 30 
days of first use or their license is withdrawn.    Site-License arrangements may be made by 
contacting The Flatirons Group.

Anyone distributing Maze Master for any kind of remuneration must first contact The Flatirons Group 
at the address below for authorization.    This authorization will be automatically granted to distributors 
recognized by the (ASP) as adhering to its guidelines for shareware distributors, and such distributors 
may begin offering Maze Master immediately.    (However The Flatirons Group must still be advised so 
that the distributor can be kept up-to-date with the latest version of Maze Master.) 

You are encouraged to pass a copy of Maze Master along to your friends for evaluation.    Please 
encourage them to register their copy if they find that they can use it. 

Bonus for Registered Users:



All registered users will receive a copy of the latest version of Maze Master, a set of extended sound 
effects, support for one year, and notification of updates (with discounts).

Related Topics

Registration Instructions and Warranty
Registration Form



Registration Instructions and Warranty

This section contains instructions for registering Maze Master.    Maze Master is shareware; it is 
copyrighted software.    You are obliged to register your copy after a reasonable evaluation period (a 
couple of weeks), or remove it from your computer(s).

To register your copy:

1. Print a copy of the registration form, and fill it out.    The registration form can be printed from 
either the plain text file included with the Maze Master package, or by printing the Registration 
Form using the Print Topic item under the File menu of this help manager.

2. Calculate the registration fee.    For US and Canadian users, the fee is $15 if you wish a diskette 
of the latest version of Maze Master, or $12 if you simply need the registration password.    For 
non-US and non-Canadian users, the fee is $20 if you wish the diskette, and $17 if you do not.    
Remember, you only get the extended sound effects if you register and request the diskette!

3. Attach a check or money order for registration fee made payable to "The Flatirons Group".    
Sorry, but no credit cards (yet!).

4. Mail the registration form and the check or money order to the address on the form.

Registration Package

Upon registering, you will receive:

* Your registration password,

* Support for the product for one full year,

* Timely notifications of new versions (at discounts) of Maze Master and other products of The 
Flatirons Group, and

* Diskette of approriate size (if requested on the form) with:

* The current version of Maze Master,

* Bonus - The extended sound effects for Windows 3.1 systems with appropriate hardware and 
drivers, and

* Bonus - Instructions for customizing the sounds to your preferences.

Warranty and Support

You are entitled to one year of support with payment of the registration fee.    This includes assistance 
getting the program running on your system.    For assistance, contact by mail:

The Flatirons Group
1550 Kalmia Ave.
Boulder, CO    80304-1817

or leave a CompuServe message via CompuServe Mail for 70053,3600.

The Flatirons Group is committed to making sure Maze Master works for you, or your registration fee 
will be cheerfully refunded.    If you have a disagreement with The Flatirons Group, the Association of 
Shareware Professionals (ASP) has an Ombudsman process in place to resolve the dispute.

ASP Ombudsman

Maze Master is produced by the Flatirons Group, a member of the Association of Shareware 
Professionals (ASP).    ASP wants to make sure that the shareware principle works for you.    If you 
are unable to resolve a software-related problem with an ASP member by contacting the member 
directly, ASP may be able to help.    The ASP Ombudsman can help you resolve a dispute or problem 
with an ASP member, but does not provide technical support form members' products.    Please write 



to the ASP Ombudsman at 545 Grover Road, Muskegon, MI    49442 or send a CompuServe 
message via CompuServe Mail to ASP Ombudsman 70007,3536.

Related Topics

Shareware -- Explanation and Benefits
Registration Form



Maze Master Registration Form
Use the Print Topic item under the File menu of this help manager to print this registration form.

To: Frederick D. George Compuserve ID: 70053,3600
The Flatirons Group
1550 Kalmia Ave.
Boulder, CO    80304-1817
USA

Please register me as a user of Maze Master. I have read and agree to the disclaimer statement in 
the Shareware section of the Maze Master help (WinMaze.Hlp).

I enclose my registration fee of $15 (US) for US and Canadian users, or $20 (US) for non-US and 
non-Canadian users.

I would like to receive Maze Master on (please circle one; you need to request a diskette to get the 
extended sound effects!):

5.25" diskette 3.5" diskette No diskette (take $3 off!)

My name is: ___________________________________________

My address is: ___________________________________________

___________________________________________

___________________________________________

___________________________________________ (ZIP Code)

___________________________________________ (Country)

Telephone: ___________________________________________ 

Signed: ________________________________ Date: ___________________

If you could spare the time to fill in the following few details, it would help to ensure that future 
products meet users' needs, and are distributed quickly and efficiently.

I obtained Maze Master from:

        Bulletin Board:_____________________    Distributor:____________________

        Another user:_____________________      Other:________________________

Comments and suggestions (improvements, new features, new programs, etc.):

___________________________________________________________________________ 

___________________________________________________________________________ 

___________________________________________________________________________ 

___________________________________________________________________________



Score Dialog

This section contains information about the fields in the Score dialog in Maze Master.

Maze Type field

Shows the type of maze you were solving, beginner, intermediate, expert, monster, or custom.    If a 
record was set, there will be blue ribbons beside the name.

Score fields

Shows the Base Score (points earned for solving the maze, less points for dead ends taken), the 
Time Bonus    (points earned for solving the maze quickly), and the Total Score.    Scores are higher if 
advanced wall settings (high, blind mouse, or glass) are used.    Remember, your time bonus will 
never be larger than the base score, even if you solved the maze very fast!

Other Data fields

Shows    the number of steps on the path which solves the maze (Maze Length),    the number of dead 
end steps you took (Dead Ends), the time it took you to solve the maze starting from when you first 
got down on all four feet (Drawing Time),    and the time it took you to solve the maze starting from 
when the maze first appeared (Total Time).

Player Name field

This field appears only if you set an all-time record or a daily record.    Put your name in this field (if it 
isn't already there).    Your record is dated automatically, so you need not add it to your name as is 
often done.

Action area

There are five push buttons here.    OK returns you to the maze.    Best brings up the Top Scores 
Dialog, showing the top 5 all-time scores, and the top 5 daily scores.    Help brings you to this screen.

There are five push buttons here:

 returns you to the maze,

 brings up the Top Scores Dialog, showing the top 5 all-time scores, and the top 5 daily scores, 
and

 brings you to this screen.



Top Scores Dialog

This section contains information about the Top Scores dialog in Maze Master.

Maze Type field

Shows the type of maze you were solving, beginner, intermediate, expert, or monster (no records are 
kept for custom    mazes).

Hall of Fame area

Shows the top 5 all-time scores.    The fields are explained below.

Today's Best area

Shows the top 5 scores from today's play.    The fields are explained below.

Score field

The total score for the record game.

Name field

Name of the record holder.

Date field

Date of the record game.

Maze Number field

The particular maze solved for the record.    If you wish to try to beat the record, select that game 
number along with the correct size in the Custom Maze Dialog , accessed from the Custom choice in 
the Size menu item.

Walls field

Walls setting for the record game (low, high, blind mouse, or glass).    The walls setting is accessed 
through the Walls menu item.    Remember, points are multiplied for advanced wall settings (see 
Scoring ).

Action area

There are five push buttons here:

 returns you to the maze,

 brings you to this screen,

 resets all the records (after confirmation),

 shows the records for the next larger size maze, and

 shows the records for the next smaller size maze.



Custom Maze Dialog

This section contains information about the Custom Maze dialog in Maze Master.

Size fields

Allows you to set the Width and Height of the maze you wish to solve.    Range checking is performed.

Number field

The number of a maze (as taken from the window title).    For any given size, the maze number is 
unique for a maze.    If you wish to solve a maze for which a record was set, enter the maze number 
from the Top Score Dialog  in this field.

Action area

There are three push buttons here.    OK changes the maze size and draws the maze.    Cancel takes 
you back to the maze.    And Help brings you to this screen.



Registration Dialog

This section contains information about the Registration dialog in Maze Master.

Owner field

Allows you to enter the owner name.    Use the name exactly as shown on the registration form you 
received.

Password field

Allows you to enter the registration password.    Use the password exactly as shown on the 
registration form you received.

Action area

There are three push buttons here.    OK validates the owner name and password.    If valid, a thank 
you note is shown; if invalid, you are prompted to enter it again carefully.    Cancel takes you back to 
the maze.    And Help brings you to this screen.

Related Topics

Shareware -- Explanation and Benefits
Registration Instructions and Warranty
Registration Form



Batch Print Dialog

This section contains information about the Batch Print dialog in Maze Master.

Count field

Requests the number of mazes you wish to print.    The size of the maze is the size being displayed at 
the time this dialog is displayed.    The default number is ten (10); the minimum number is zero (0), 
and the maximum is one hundred (100).

Action area

There are three push buttons here.    OK proceeds to print the number of mazes requested in the 
count field.    Cancel takes you back to the maze.    And Help brings you to this screen.



Your Base Score is points you get by solving the maze.    You get points for each step in the solution, 
but you are penalized points for dead ends you try.



Your Time Bonus is points you get by solving the maze fast.    You start with bonus points based on 
the size of the maze and the walls selection.    Then the bonus is reduced by 250 points for each 
second it takes you to solve the maze.    The bonus will not be less than 0.



Your Total Score is the total of your Base Score and your Time Bonus.



Dead Ends are maze paths which lead nowhere.    They are counted in steps.    For example, if you go 
3 steps into a dead end, your dead end count goes up by 3.



The Maze Length is the total number of steps on the shortest path between the beginning and end of 
the maze.



The Drawing Time is the time it takes for the mouse to solve the maze, counting from the time the 
mouse enters the maze. 



The Total Time is the time it takes for you to solve a maze, including the time to study it before starting 
through the maze.



Beginner mazes are 8 by 8 cells.



Intermediate mazes are 14 by 14 cells.



Expert mazes are 20 by 20 cells.



Monster mazes are 40 by 40 cells.



Custom mazes may be any (reasonable) size.    They are set through a dialog invoked by the Custom 
choice of the Size menu item.



Low walls allow you to see the whole maze before you start.    You can peek ahead, or even trace a 
path back from the end.



High walls prevent you from seeing the maze until you enter.    Then, you can only see to the walls on 
each side of you.    This is how a mouse really runs a maze!



A blind mouse cannot see ahead at all, but can only feel the walls around it (if any)!



Glass walls are like the house of glass at carnivals -- the only way you know a wall is there is to bump 
your nose into it.    You need a great memory (or a small maze) to handle this type!




